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Welcome

Welcome to the developer hands-on workshop for SAP NetWeaver Cloud Portal and SAPUI5. Over the next two
hours, you will build rich, branded and customizable application user interfaces and deploy them to the SAP cloud.
After this session, you will be equipped with the knowledge and skills to quickly build and design your own application
site composed of widgets and pages, using the SAPUI5 html5 libraries, the standard Open Social component model
and Open Social features implemented by NetWeaver Cloud Portal and the NetWeaver Cloud Portal authoring
environment.

Application Description

In this workshop, you will enhance the user interface of a simple application that allows a user to schedule events,
choose venues and assign participants. The main focus will be “widgetizing” this application by writing Open Social
specification XMLs that include JavaScript and HTML code that in turn rely on SAPUI5 and NW Cloud Portal libraries.
The application will leverage the key services of the NetWeaver Cloud Portal including branding, persistence, context,
personalization and embedded support for SAPUIS.

Workshop Agenda

This workshop is structured into 9 exercises, as follows:

1. Configure development environment and load the initial web application;

2. “Widgetize” the Events Section with UI5 controls — Table widget, Details widget, Map widget;

3. “Widgetize” the Event Venues Section — Table widget with alternative expanded view, Map widget;
4. “Widgetize” the My Team Section with UI5 controls - Table widget, Details widget;

5. Add Cloud Portal Open Social Features;

6. Deploy the Widgets to NW Cloud and expose in NW Cloud Portal;

7. Authoring the Application Site;

8. Theming and Branding the Site;

9. Publishing the Site.

In this first exercise we will start the eclipse IDE, verify the NW Cloud settings and finally import a simple web
application that will serve both as our base application and the starting point Ul. We will use the same IDE used for
NetWeaver Cloud hands-on session CD261.



Verify eclipse settings
1. Start Eclipse

a. Click on Start 2All Programs =2Eclipse 2Eclipse Juno J2EE — CD261.
If a security warning message appears, just click on Run.

¥ Adobe Reader X - —

1= Fiddler2 ‘.

&2 PuTTY |
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| Administrative Tools B
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k. Apac Documents
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2. Verify Proxy Settings
a. In Eclipse, click on Window >Preferences.

b. Open the General tab and click on Network Connections.

c. Verify that at least the entries listed below are checked. If not, then update accordingly by switching to
Active Provider to Manual first.

Proxy entries:
HTTP, proxy, 8080, False

HTTPS, proxy, 8080, False

Proxy bypass:
*.sap.corp

nexus
localhost
10.%.**



ﬂ Preferences C=RACE
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3. Verify Target Runtime Settings
a. Inthe Preferences window, open the Server tab.
b. Click on Runtime Environments.
c. Verify that there is a SAP NetWeaver Cloud entry. Click on it and then click on the Edit button.

PR —————— 2

type filter text Server Runtime Environments Py
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d. Verify that the popup window contains the following information:



= Name: SAP NetWeaver Cloud
= Build environment: Choose existing target definition: SAP NetWeaver Cloud SDK.
= Click on the Cancel button.

. Edit Server Runtime Environment

SAP NetWeaver Cloud @

Configure the build environment for SAP NetWeaver Cloud applications. e

Name: EAP NetWeaver Cloud

Build environment

() Use SAP NetWeaver Cloud SDK from the following location:

‘ \\fairfile.fair.sap.corp\Sessiom\CD261\neo-sdk-1.7.1 ‘ ‘ Browse..‘|

(@ Choose existing target definition:

[SAP NetWeaver Cloud SDK '] Manage...
@ | <Back | Net> [ Fnsh ][ cancel

4. Verify NW Cloud Server Settings
a. Inthe Preferences window, still in the Server tab, click on SAP NetWeaver Cloud.
b. Verify the following fields:
= Landscape host: netweaver.ondemand.com
=  SDK location: \\fairfile.fair.sap.corp\Session\CD261\neo-sdk-1.7.1

c. Update the following fields:

= Account name: teched<your assigned number> (e.g. teched100)

= User name: <your assigned username>
d. Click on the Validate button and verify a positive validation result in a popup window. Click on OK.
e. Click on the Apply button.


file://fairfile.fair.sap.corp/Session/CD261/neo-sdk-1.7.1
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Account information
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Always overwrite and restart applications without warning me
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Import the initial events management web project

Import the war file into a new web project

In Eclipse, click on File=>Import...

b. Select import source: Web>WAR file



Select N\d
Import an external WAR file into a Web Project I-H]

Select an import source:
| type filter text

I = Plug-in Development -
I = Remote Systems
i+ = Run/Debug

I = Tasks

= Team

4 = Web

@ WAR file|

i = Web services

I = XML

4

©) <Back | Net» || nsh | cancel

c. Click Next
d. Browse to war file \\fairfile.fair.sap.corp\session\CD360\eventsinitial.war war file
e. Name the Web project eventsinitial

WAR Import C
' 0‘

Import a WAR file from the file system

WAR file: \\fairfile.fair.sap.corp\session\CD360\eventsinitial.war - ‘QWSe..,

Web project: v

Target runtime: ISAP NetWeaver Cloud '] [ New... ]
EAR membership
(] Add project to an EAR
EAR project name: | eventscloudportal4EAR v‘ New Project..
®@ [ <Bak |  Net> |[ Ensh ][ cancel

f.  Click Finish

g. Optional: browse through the new project’s JavaScript and HTML source code


file://fairfile.fair.sap.corp/session/CD360/eventsinitial.war
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Get to know the application functionality
1. Run the application
a. In Firefox or Chrome open URL

https://eventsteched2012.netweaver.ondemand.com/eventsinitial/index.html;
if prompted, login with your SCN credentials

Import the widgetized events management web project

As a preparation to the next exercises, we will now import another web project, this time containing the source code for
the widgetized version of the events management application.
a. In Eclipse, click on File>Import...

b. Select import source: Web->WAR file


https://eventsteched2012.netweaver.ondemand.com/eventsinitial/index.html

Select N\d
Import an external WAR file into a Web Project M

Select an import source:
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I = XML

4
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c. Click Next
d. Browse to war file \\fairfile.fair.sap.corp\session\CD360\eventswidgets.war
Name the Web project eventswidgets

WAR Import

Import a WAR file from the file system Céj
WAR file: \fairfile.fair.sap.corp\session\CD360\eventswidgets.war i d
Web project:  eventswidgets -
Target runtime: ISAP NetWeaver Cloud '] [ New... ]
EAR membership
|_| Add project to an EAR
EAR project name: | eventscloudportal4EAR v‘ New Project...
®@ [ <Bak |  Net> |[ Ensh ][ cancel
f.  Click Finish

g. This should be the result:
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The next four exercises deal with the creation of the widgets. Generally, every widget is defined by an Open Social
specification XML file (or spec XML); the JavaScript and HTML source code used by the widget can either be included
directly in the spec XML or referenced using a bootstrap mechanism used in the Cloud Portal. We will see both types in
the following exercises. Due to time constraints we will not do most of the actual coding during the session.

In Exercise 2 we will wigetize the Events section creating three widgets: a table widget holding the events data, a
participant detail widget that shows information about the people attending a selected event and a map widget showing
the venue location of a selected event in Google maps.

Event Table Widget

1. Create a new xml file for the events table widget

a. Inthe eventswidgets web project imported in the former step browse to folder events
b. Right click on the folder and choose New—>File



C.

d.
e.
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% events100.xml &
E |

4

Design | Source

f.  Enter the following snippet:

<?xml version="1.0" encoding="UTF-8"?>
<Module>

<ModulePrefs title="Events">
</ModulePrefs>

<Content type="htmlL">
<! [CDATA[

11>
</Content>
</Module>

This is the most basic form of a spec XML; it composes of one main Module section that in turn holds
two sections: ModulePrefs and Content. The ModulePrefs is the header where widget properties are
defined (e.g. title) and Open Social features are declared; the content is the actual source code of the
widget

g. Add the Open Social feature declarations to ModulePrefs section:



<?xml version="1.0" encoding="UTF-8"?>
<Module>

<ModulePrefs title="Events">

<!--START: SAPUI5 feature-->
<Require feature="sap-ui5">
<Param name="sap-ui-params"></Param>
</Require>
<!--END: SAPUIS5 feature-->

<!--START: Publish/Subscribe feature-->
<Require feature="pubsub-2"/>

<Require feature="sap-context"/>
<!--END: Publish/Subscribe feature-->

</ModulePrefs>

<Content type="htmlL">
<! [CDATA[

11>
</Content>
</Module>

In this widget we will use the SAPUIS5 feature enabling the usage of the SAPUIS5 libraries within the
widget (with no additional imports) and the Publish/Subscribe feature allowing widgets to communicate
with each other.

Now add the content section:



<?xml version="1.0" encoding="UTF-8"?>
<Module>

<ModulePrefs title="Events">

<!--START: SAPUI5 feature-->
<Require feature="sap-ui5">
<Param name="sap-ui-params"></Param>
</Require>
<!--END: SAPUI5 feature-->

<!--START: Publish/Subscribe feature-->
<Require feature="pubsub-2"/>

<Require feature="sap-context"/>
<!--END: Publish/Subscribe feature-->

</ModulePrefs>

<Content type="htmlL">
<! [CDATA[
<body class="sapUiBody" role="application">
<div id="content"></div>
</body>

<script>
var onLoad = function(){
var url = gadgets.util.getUrlParameters().url,
path = url.substring(@,url.lastIndex0f('/"));

jQuery.sap.registerModulePath("common", gadgets.io.getProxyUrl(path +
"/../../common").replace('?"', '?nocache=1&")) ;

jQuery.sap.registerModulePath("eventController"”, gadgets.io.getProxyUrl(path +
"/events.controller"));

jQuery.sap.registerModulePath("eventView", gadgets.io.getProxyUrl(path +
"/events.view"));

jQuery.sap.registerModulePath("date", gadgets.io.getProxyUrl(path +
"/../../date/date"));

jQuery.sap.registerModulePath("url"”, gadgets.io.getProxyUrl(path +

"/../../xml-url").replace('?"', '?nocache=1&"));

jQuery.sap.require("common");
jQuery.sap.require("eventController");
jQuery.sap.require("eventView");
jQuery.sap.require("date");
jQuery.sap.require("url");

var view = sap.ui.view({
viewName: "event.management.events",
type:sap.ui.core.mvc.ViewType.3JS

1)

view.placeAt("content");

gadgets.util.registerOnLoadHandler(onLoad);
</script>

11>
</Content>
</Module>

The Content is composed of standard HTML and JavaScript code within CDATA. It has a very simple
body section defining a div and a script that is used to bootstrap 5 additional JavaScript files using
jQuery APIs and to define and place a SAPUI5 view. The referenced files are already in the same
events folder within the eventswidgets project, notice they are almost identical to the ones used in the
eventsinitial project. Whenever a row is selected in the table, an event is published with the row
context, enabling the other widgets to respond (implemented in the events.view.js file).

2. Save the XML file



Map Widget

1. Create a new xml file for the events map widget

a. Follow the same steps as before, name the new file event-map<your account suffix>.xml (e.g. event-
map100.xml)

b. Edit the new file and enter the following snippet to the source tab:

<?xml version="1.0" encoding="UTF-8"?>
<Module>
<ModulePrefs title="Events Google Maps Subscriber" height="250">
<!--START: Publish/Subscribe feature-->
<Require feature="pubsub-2"/>
<Require feature="sap-context"/>
<!--END: Publish/Subscribe feature-->
</ModulePrefs>
<Content type="htmlL">
<! [CDATA[
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-
transitional.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml" style="height:100%; width:100%">
<head>
<script language="JavaScript">
var onLoad = function(){

/* START: Subscriber functionality */

var subld;
var googleMapUrlPrefix = "http://maps.google.com/maps?output=embed&t=m&num=1&q=";

function updateMap (topic, context) {

if (topic === "init-sub") {
return;
}
var location = context.getPropertyByKey("eventLocation")[0];
if (location !== "") {
document.getElementById( 'mapIframe').src = googleMapUrlPrefix + (location);
}
}
/*
* Subscribe to Site Context using sap-context feature.
*/

var subscribe = function subscribe() {
subId = gadgets.sapcontext.subscribe(updateMap);
}

setTimeout(subscribe,500);

/* END: Subscriber functionality */

gadgets.util.registerOnLoadHandler(onLoad);
</script>
</head>

<body bgcolor="white" style="font-family:Arial;height:100%; width:100%; margin: 0;">

<div id="googleMap" style="height:100%; width:100%">
<iframe id="mapIframe" frameBorder="0"
src="http://maps.google.com/maps?output=embed&t=m&num=1&q=usa" style="height:100%; width:100%"></iframe>
</div>

</body>
</html>
11>

</Content>
</Module>

As you can see, this spec XML is different than the events.xml in that the source code is entirely
embedded in the content CDATA section. Using the Publish-Subscribe feature, it responds to a row



selection event in the event table widget by subscribing to the corresponding event and changing the
query URL sent to the Google map API to match the selected row’s venue location.

2. Save the XML file

Participants Details Widget

1. Create a new xml file for the participants details widget

a. Follow the same steps as before, name the new file events.people<your account suffix>.xml (e.g.
events.peoplel100.xml)

b. Edit the new file and enter the following snippet to the source tab:

<?xml version="1.0" encoding="UTF-8"?>
<Module>

<ModulePrefs title="Events Attending People">

<!--START: SAPUI5 feature-->
<Require feature="sap-ui5">
<Param name="sap-ui-params"></Param>
</Require>
<!--END: SAPUI5 feature-->

<!--START: Publish/Subscribe feature-->
<Require feature="pubsub-2" />

<Require feature="sap-context" />
<!--START: Publish/Subscribe feature-->

</ModulePrefs>

<Content type="htmlL">
<1 [CDATA[
<body class="sapUiBody" role="application">
<div id="people"></div>
</body>

<script>
var onLoad = function(){

var url = gadgets.util.getUrlParameters().url,
path = url.substring(@,url.lastIndex0f('/"));

jQuery.sap.registerModulePath("common", gadgets.io.getProxyUrl(path
"/../../common").replace('?"', '?nocache=1&")) ;

jQuery.sap.registerModulePath("eventController"”, gadgets.io.getProxyUrl(path
"/events.controller"));

jQuery.sap.registerModulePath("eventPeopleView", gadgets.io.getProxyUrl(path +
"/events.people.view"));

a5

&

jQuery.sap.registerModulePath("date", gadgets.io.getProxyUrl(path +
"/../../date/date"));
jQuery.sap.registerModulePath("url", gadgets.io.getProxyUrl(path + "/../../xml-

url").replace('?', '?nocache=18&"));

jQuery.sap.require("common");
jQuery.sap.require("eventController");
jQuery.sap.require("eventPeopleView");
jQuery.sap.require("date");
jQuery.sap.require("url");

var view = sap.ui.view({
viewName:"event.management.events.people”,
type:sap.ui.core.mvc.ViewType.3JS
1
view.placeAt("people");
}
gadgets.util.registerOnLoadHandler(onLoad);
</script>

11>
</Content>
</Module>




Although this spec XML seems quite similar to the events.xml, the content is entirely different; the main
part is implemented in the referenced events.people.view.js file. Similar to the map widget, also this
widget responds to the selection of a row in the event table widget by displaying all the participants of
the selected event.

2. Save the XML file

In the next exercise we will widgetize the Events Venues section. This page will be composed of two widgets: a table
widget listing the different available venues that enabled adding, deleting and editing these venues, and a map widget
that shows the selected venue location on Google maps (identical to the map widget in the events page). This page will
have has an alternative display mode: a custom menu in the venue table widget enables toggling between the Table +
Map widget and a single expanded map view showing all the venue locations together in the same map.

Venue Table Widget

1. Create a new xml file for the participants details widget

a. Follow the same steps as before this time starting from the venues folder; name the new file event-
venues<your account suffix>.xml (e.g. event-venues100.xml)

b. Edit the new file and enter the following snippet to the source tab:



<?xml version="1.0" encoding="UTF-8"?>
<Module>

<ModulePrefs title="Event Venues">

<!--START: SAPUI5 feature-->
<Require feature="sap-ui5">
<Param name="sap-ui-params"></Param>
</Require>
<!--END: SAPUI5 feature-->

<!--START: Publish/Subscribe feature-->
<Require feature="pubsub-2"/>

<Require feature="sap-context"/>
<!--END: Publish/Subscribe feature-->

<!--START: Maximize Feature-->
<Require feature="sap-widget"/>
<!--END: Maximize Feature-->

<!--START: Menu Feature-->
<Require feature="sap-menu"/>
<!--END: Menu Feature-->

<!--START: Gadget Preferences Feature-->
<Require feature="gadgetprefs"/>
<!--END: Gadget Preferences Feature-->

</ModulePrefs>

<Content type="htmlL">
<! [CDATA[
<body class="sapUiBody" role="application">
<div id="content"></div>
</body>

<script>
var onLoad = function(){

var url = gadgets.util.getUrlParameters().url,
path = url.substring(@,url.lastIndex0f('/"));

jQuery.sap.registerModulePath("common", gadgets.io.getProxyUrl(path
"/../../common").replace('?"', '?nocache=1&")) ;

jQuery.sap.registerModulePath("locationController", gadgets.io.getProxyUrl(path
"/locations.controller"));

+

a5

jQuery.sap.registerModulePath("locationview", gadgets.io.getProxyUrl(path +
"/locations.view"));

jQuery.sap.registerModulePath("date", gadgets.io.getProxyUrl(path +
"/../../date/date"));

jQuery.sap.registerModulePath("url", gadgets.io.getProxyUrl(path + "/../../xml-

url").replace('?', '?nocache=1&'));

jQuery.sap.require("common");
jQuery.sap.require("locationController");
jQuery.sap.require("locationView");
jQuery.sap.require("date");
jQuery.sap.require("url");

var view = sap.ui.view({
viewName: "event.management.locations",
type:sap.ui.core.mvc.ViewType.3JS

1)

view.placeAt("content");

}

gadgets.util.registerOnLoadHandler(onLoad);
</script>

11>
</Content>
</Module>

As you can see in the ModulePrefs section, this widgets uses some new Open Social features: in
addition to SAPUI5 and Publish/Subscribe we already saw, also the Maximize, Menu and Gadget
Preferences features are used here. We will take a closer look at these features in exercise 5.

2. Save the XML file



Venue Map Widget

1. By now we know how to create the spec XMLs, therefore in the next widgets we will only browse through the
code of the XMLs already created in the eventswidgets project.
a. From the venues folder, open file event-venues-map.xml
b. Browse through the code in the source tab; as you can see it's almost identical to the map widget in
the events page.

In this short exercise we will browse through the code of the two widgets composing the My Team section: Team Table
widget and Team Details widget. Both widgets include code similar to what we have already seen in the previous

widgets.
Team Table Widget

1. Browse through the code of file team.xml
a. From the team folder, open file team.xml
b. Browse through the code in the source tab; as you can see it’s very similar to the other table widgets.

Team Details Widget

1. Browse through the code of file team.details.xml
a. From the team folder, open file team.details.xml
b. Browse through the code in the source tab; as you can see it's almost identical to the Participants
Details widget in the events page.

In this exercise we will take a deeper look at some of the Cloud Portal Open Social features. Specifically, we’'ll see the
use of features Publish/Subscribe, Menu and Gadget Preferences. Declaring these (or any other) features in the widget
spec XML will load the required code at client runtime, so developers can just use the APIs for these features without

worrying about the implementation.

Publish/Subscribe Feature

This feature allows different widgets to communicate with each other; this is achieved by an eventing mechanism
where widgets can publish key value pairs (usually based on runtime events) while other widgets can subscribe to
these keys. When a subscribed key is published, value is passed to the subscribed widget that can then react. A
simple example is the communication between the Events Table widget and the Event Map widget. We’d like to show
an event venue location in map widget whenever an event is selected in the events table.



1. Publish - browse through the code of the events table widget
a. Open file events.xml from the folder events in the eventswidget project

b. Notice that the feature is declared in the ModulePrefs section:

<Require feature="pubsub-2"/>

<Require feature="sap-context"/>

c. Browse through the following code in file events.view.js:

var onSelect = function(oEvent) {
// get the binding context of the first selected row
var oContext = oEvent.getParameter("rowContext");

var oModel = oEvent.getSource().getModel();

var people = oModel.getProperty("person",
oContext);

var venue = oModel.getProperty("eventLocation",
oContext);

/* START: Publish Events*/

publish("eventPeople", people);
publish("eventLocation", venue.name);

/* END: Publish Events*/

s

/* START: Define Publish Function*/

var publish = function publish(key, value) {
gadgets.sapcontext.publish(key, value);

}s

/* END: Define Publish Function*/

As you can see, when a row is selected in the table, the following key value pairs are published:
(“eventPeople”, people) and (“eventLocation”, venue.name). The function implementation simple
consists of a call to the API: gadgets.sapcontext.publish(key, value).

2. Subscribe - browse through the code of the events map widget

a. Open file event-map.xml from the folder events in the eventswidget project

b. Notice that also here the same feature is declared in the ModulePrefs section:

<Require feature="pubsub-2"/>

<Require feature="sap-context"/>

c. Now browse through the following code in event-map.xml:



/* START: Subscriber functionality */

var subld;
var googleMapUrlPrefix = "http://maps.google.com/maps?output=embed&t=m&num=1&q=";

function updateMap (topic, context) {

if (topic === "init-sub") {
return;
¥
var location = context.getPropertyByKey("eventLocation")[0];
if (location !== "") {
document.getElementById( 'mapIframe').src = googleMapUrlPrefix + (location);
¥
}
/*
* Subscribe to Site Context using sap-context feature.
*/

var subscribe = function subscribe() {
subId = gadgets.sapcontext.subscribe(updateMap);
}

setTimeout(subscribe,500);

/* END: Subscriber functionality */

As you can see, the updateMap function reacts to a publish event by updating the Google maps URL
with the value of the key eventLocation.

Menu Feature

This feature enables the development of a custom menu to a widget. It is used in the venue table widget to switch
between a table view and an expanded map view of all venue locations

1. Browse through the code of the venue table widget
a. Open file event-venues.xml from the folder venues in the eventswidget project

b. Notice that the feature is declared in the ModulePrefs section:

<Require feature="sap-menu"/>

c. Browse through the following code in file events.view.js:



/* START: MENU Feature*/
gadgets.sap.menu.remove ({

ID: Constants.MENU_ID
1

//Add View Change Menu action
gadgets.sap.menu.addMenu({

ID: Constants.MENU_ID,

tooltip: 'Change View',

icon: Constants.MENU_ICON_REGULAR,

hoverIcon: Constants.MENU_ICON_HOVER
1

//Table View Menu Item Creation
gadgets.sap.menu.addMenuItem({
ID: Constants.VIEWS.TABLE.ID,
menuID: Constants.MENU_ID,
text: 'Table View',
icon: Constants.VIEWS.TABLE.MENU_ITEM_ICON,
callback: function switchToTableView() {
prefs.setPreference("viewMode", "table");
//Restore
if (parent.App.base.isDefined(widget)) {
widget.callbacks.restore.reduce();
}

}.bind(this)
s

//Map View Menu Item Creation
gadgets.sap.menu.addMenuItem({
ID: Constants.VIEWS.MAP.ID,
menuID: Constants.MENU_ID,
text: 'Map View',
icon: Constants.VIEWS.MAP.MENU_ITEM_ICON,
callback: switchToMapView.bind(this)
s

/* END: MENU Feature*/

Using this feature a custom menu and two menu items are added to the menu: Table View and Map
View. Selection of these menu items will call functions switching to the selected view.

Gadget Preferences Feature

This feature enables persistence of user preferences with regards to widget attributes. It is used here also in the venue
table widget to save the user’s view preference (table or map).

1. Browse again through the code of the venue table widget
a. Open file event-venues.xml from the folder venues in the eventswidget project

b. Notice that the feature is declared in the ModulePrefs section:

| <Require feature="gadgetprefs"/> I

c. Browse through the following code in file events.view.js:




var prefs = new gadgets.GadgetPrefs(),
moduleIld = prefs.getWidgetId(),
widget = parent.App.workspace.controller.getWidget(moduleId);

function switchToTableView() {
prefs.setPreference("viewMode", "table");
//Restore
if (parent.App.base.isDefined(widget)) {

widget.callbacks.restore.reduce(); }

function switchToMapView() {

prefs.setPreference("viewMode", "maximize");
gadgets.sap.widget.openView({
mode: "maximize",
url: locationString,
contentType: "url",
stateful: true,
listeners: {
¥
1
¥

Every time a view mode changes, this selection is saved to the persisted prefs variable, so that the
next time the user enters this page, the previous display mode will be active.

In this exercise we will deploy the widgets to NetWeaver Cloud and add them as Open Social widgets to the Cloud
Portal content catalog.

Deploy widgets to NetWeaver Cloud

1. Ineclipse, right click on the eventswidget project and choose Run As - Run on Server:

[ idmate
New 4

Go Into

Show In Alt+Shift+W

Copy Ctrl+C
Copy Qualified Name

Paste Cirl+V
Delete Delete
Remove from Context Ctrl +Alt+Shift+Down
Build Path 4
Refactor Alt+Shift+T»

LB v | B P

x [ (07

Import 4
Export 4

] Refresh F5
Close Project
Close Unrelated Projects
@
» & H

. Validate

Show in Remote Systems view
Run As

Debug As

Profile As

Team

1 Run on Server Alt+Shift+X, R
2 Java Applet Alt+Shift+X, A
3 Java Application Alt+Shift+X, ]

C I i

Run Configurations...

Compare With

Restore from Local History...
Java EE Tools L4
Configure 4
Source *

Properties Alt+Enter




2. Create a new server
a. Inthe Run On Server wizard, choose the Manually define a new server
b. In Server Type choose SAP NetWeaver Cloud
c. Server host name should be netweaver.ondemand.com (this is the default)
d

Change the Server name to t<your account suffix>.netweaver.ondemand.com, e.g.
1100.netweaver.ondemand.com

e. Server runtime environment should be SAP NetWeaver Cloud (this is the default)
f.  Click Next
.1' Run On Server EE 25 -
Run On Server E
Select which server to use

How do you want to select the server?
() Choose an existing server i
(@ Manually define a new server

Download additional server adapters

Select the server type:

type filter text
a (= SAP -
1 Local Test Server for SAP NetWeaver Cloud @
o SAP NetWeaver Cloud et
Publishes and runs Java applications on SAP NetWeaver Cloud. I
7
Server's host name: netweaver.ondemand.com
Server name: 100.netweaver.ondemand.com B
Server runtime environment: |SAP NetWeaver Cloud > | Add..

Configure runtime environments...

Always use this server when running this project

@ . <gack | Nea> || Fnsn || cancel |

g. Inthe next screen, in application name type t<your account suffix>, e.g. t100
h. In Account name type teched<your account suffix>, e.g. teched100

i. Enter your assigned username and password, e.g. P1170492/Abcd1234

j.  Click Finish



I SAP NetWeaver Cloud Application @ |

Specify application name and account data. i

Application name: t100

Account information

Account name:  teched100
User name: P1170492
Password:

Save password (could trigger secure storage login)

[ <Bak [ met> J[ gnsn || cance |

In the bottom right corner of eclipse you’ll notice that the application is being deployed, this might take a few

minutes

Starting t100.netweaver..mand.com: (15%) - = @

When this is done, you should see the following in the Servers tab in the lower part of eclipse:

[2: Markers [ Properties i Servers 2 ¥ Data Source Explorer &3 Snippets =g Progress BS Oy 80

=

4 |3 t100.netweaver.ondemand.com [Started, Synchronized]
% eventswidgets [Synchronized]

Next step is testing the URLSs to the deployed spec XMLs. Generally, the path is
https://<your application name><your account name>.netweaver.ondemand.com/eventswidgets/<path to XML
as in the eventswidgets project>;
e.g. https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues.xml
a. Make sure entering the following URLSs in a browser show the expected XML files
Note that these are just examples for application t100 and account teched100:

Vi.
Vii.

https://t100teched100.netweaver.ondemand.com/eventswidgetsl/widgets-
src/events/events.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/event-
map.xml

https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-
src/events/events.people.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-
venues.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-
venues-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/team/team.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-
src/team/team.details.xml



https://t100teched100.netweaver.ondemand.com/eventswidgets1/widgets-src/events/events.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets1/widgets-src/events/events.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/event-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/event-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/events.people.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/events.people.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/team/team.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/team/team.details.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/team/team.details.xml

Create Open Social widgets in Cloud Portal
We will now import the widgets to Cloud Portal and add them to the content catalog

1. Logon to Cloud Portal
a. Open the browser. And go to
https://cloudsessionbteched2012-<your account name>.netweaver.ondemand.com/portal/index.html,
e.g.: https://cloudsessionbteched2012-teched100.netweaver.ondemand.com/portal/index.html
b. On the SDN login screen sign on with the given credentials
2. Navigate to Content tab:

SAP  SAP NetWeaver Cloud Portal HeloBen |

CONTENT

Use the tables in each tab to manage content available in the content catalog. Each tab represents a different content provider.

Generic Widgets

Widgets Available in Content Catalog

+ Add Widget

Name Description Calegories Type URL
S URL Widget Atemplate usedto display an extemal webpage  Templates OpenSosial Base/xmllURLxml
j=ic] Group Widget Awidgetusedto display a number of related widget  Templates OpenSocial Basexmligroupxmi
Image Widget Atemplate used to dieplay an image Templates Opensodial Basenml/ecmiecmimage xmi
] Document Widget Atemplate used to display a document Templates Opensodial BaseixmllecmiecmDocxmi

3. Add OpenSocial widgets
a. Click on +Add widget button

URL
BaseMmUURLxmi
Basemi/group.xmi

Basenmiiecvecmimage ami

Basehmi/ecmvecmDocxmi

b. Inthe Add dialog enter the following:
e Type: choose OpenSocial
¢ Name: <see table below>
Description: <free text> (optional)
Icon: <any image you see fit> (optional)
Categories: TechEd (optional)
e URL: <see table below>
c. Click Save

Add Widget

OpenSocial

Events Table

List of events
Description

Icon (gif, jpg; pna) I Browse..

TechEd

00r ondemand.com. idgets1iwidgets-src/eventsievents xml

8ave § Cancel



https://cloudsessionbteched2012-teched100.netweaver.ondemand.com/portal/index.html

d. Repeat this step for all 7 widgets using values from this table:

Widget Widget

Type Name Categories URL

Open Social Events TechEd https://t100teched100.netweaver.ondemand.com/eventswidgets1/widgets-
Table src/events/events.xml
Open Social Events Map | TechEd https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-

src/events/event-map.xml

Open Social Ever_1t§ TechEd https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-
Participants src/events/events.people.xml

Open Social Venues TechEd https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-
Table src/venues/event-venues.xml

Open Social Venues TechEd https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-
Map src/venues/event-venues-map.xml

Open Social Team Table | TechEd https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-

src/team/team.xml

Open Social Person TechEd https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-

Details src/team/team.details.xml

e. The Content Catalog should now look like this:

SAP SAP NetWeaver Cloud Portal Hello Ben |

CONTENT

Use the tables in each tab to manage content available in the content catalog. Each tab represents a different content provider.

Generic Widgets.

Widgets Available in Content Catalog

+ Add Widget

Name Description Categories Type URL
@ URL Widget Atemplate usedto display an external web page Templates OpenSocial BasexmIURL xmi
ER Group Widget A widget used to display a number of related widget  Templates OpenSocial Basefmilgroupxml
.| Image Widget Atemplate usedto display an image Templates OpenSocial Bas efxmi/ecmiecmimage xmi

Document Widget Atempiate usedto display a document Templates OpenSocial BaselxmilecmiecmDoc.ml
™)  EventsTable List of events TechEd OpenSocial hitps:/echedben3teched100.netweaver andemand.com/events
= Events Participants Attending the event TechEd Opensodial https:itechedben3teched100.netweaver onde mand.com/events
™  EwntsMap Eventvenue location TechEd OpenSocial hitps:/ftechedben3teched100.netweaver ande mand.com/events
T VenuesTable Table / Map view of all events venues TechEd OpenSocial hitps:/echedben3teched100.netweaver ondemand.com/events
= \Venues Map Event venues location TechEd OpensSocial https:itechedben3teched100.netweaver. ondemand.com/events
T TeamTable List ofteam members TechEd OpenSocial hitps:/ftechedben3teched100.netweaver ande mand.com/events
= Person Details Team member image and details TechEd Opensodial https:itechedben3teched100.netweaver onde mand.com/events

In this exercise we will create a site for our application and design its layout.


https://t100teched100.netweaver.ondemand.com/eventswidgets1/widgets-src/events/events.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets1/widgets-src/events/events.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/event-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/event-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/events.people.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/events/events.people.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/venues/event-venues-map.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/team/team.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/team/team.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/team/team.details.xml
https://t100teched100.netweaver.ondemand.com/eventswidgets/widgets-src/team/team.details.xml

Create a Site

1. Navigate to Site Directory Tab
2. Click on +New Site button

SAP" SAP NetWeaver Cloud Portal Hello Nataii | ©
( SITE DIRECTORY )

® sites: Al (0) + Published (0) + New Site

Sort by: Name =,

You have not created any sites. To create a site, choose ‘New Site"

Privacy statement | Terms of use | Legal disclosure

3. Inthe New Site dialog enter the following:
e Site name: Events On Demand
e Description: <free text>
e Click “Create and Open” button

New Site

*Site Name Events on demand

Manage events, venues and
Description participants|

Create and Open

Add widgets and design the site layout

4. Create a Site in 10 Easy Steps
a. Inthe new created site, read the Tip popup to guide you how to create a Site
b. When finishing close it by clicking the X button — top right corner



W Create a Site in 10 Easy Steps

1) Your enfry point to the SAP NetWeaver Cloud Portal is the Site Directory. This is where you
can see all your sites, and create new ones. Give your site a name and choose "Open Site
for Editing" to go to the Authoring Space.

2| Now add pages fo your site by choosing +intne page navigation bar. You can rename
pages or delete them, as required. To display the # menu for accessing the page options,
hover the cursor over the page name.

3) Add content to the page. In the side-panel menu, choose Hto open the content catalog.
This is where you will find all the widgets that you can add to your site. To add a widget to the
page, you can either double-click it to add it to the bottom of the page, or drag it from the
catalog directly to its position.

m

4 ) Finalize the look of your page:
* Move widgets around on the page fo position them. Resize widgets by dragging their
right or lower side
+ Rename widgets by double-clicking the title and typing a new name.
* Some widgets on the page may be better viewed in full-screen mode. First make sure that
there are no other widgets on the page. Then, hover the cursor over the header area of a
widget, choose ® to open the Options menu, and choose Set as Full Page.
- To remove a widget from the page, hover the cursor over the header area, choose  to
open the Options menu, and choose "Remove".

5) Select a theme for the site by choosing - in the side-panel menu, selecting one of the
provided themes, and choosing Apply Theme. When you are satisfied with the site, you can
check to see what it will look like on a tablet device. Choose [l to simulate what the site will
look like to an end user.

&) Give your users access to the site by sending them invitations to use it. Choose "™ in the
side-panel menu, and select Invite Users. Enter the full e-mail addresses of all users to whom
you want to grant access, and write a few infroductory words about the site that you are
inviting them to view.

The invitations will be sent only after you publish the site first time.

5. Rename first page
a. Inthe pages bar double click the default page name
b. The name is now editable, change it to: “Events”

c. Click Enter to apply changes
6. Open Content catalog by clicking the + icon in the site Authoring panel- blue strip on the right



SAP Events on demand
Content Catalog

Al Content (1)

Oocumentvacgn | | Evs uap
— =
Brt artcpars | | Evens Tale
&8

— mge v
(=)
Person Det: Team Table
vt e —
—

7. Optionally filter to show only the TechEd category

Content Catalog >
Filter widgets as you type Q,
TechEd (7) w

Events Map Events Paricipants

(=] [l

Events Table Person Details

(=] [

Team Table Wenues Map

(=]

Venues Table

8. Add widgets Events Table, Events Map and Events Participants by double clicking or drag and dropping the

widget to the Events page
9. Change the position and size of the widgets



SAP Events on demand

' . | Create | | Moaity | | Delete Reload

T Name Venue Start Date End Date Comment £ ﬁ
Student Day St John's Uni comment |
Intemship. Standford University 2010-01-06T12:27:001071 201009-06T12:27:001011 comment ®
fe3
A 0
] Events Participants ] Events Map
AUERTg FEopre = T =
radThve G -
FirstName | 2| St. John's University x
ve 780 Ave 3
LastName THnA A 8000 Utopia Parkway B &
Tite Queens, NY 11439 B
(718) 990-2000 e
Job Title stjohns.edu L
— TRAS 29 reviews =
Work# 2 B 2 Ef d
3 g 5 @2 | Directions Search nearby more~ v oo
Mabile # = 2 ¢ 2
= ) =
FirstName Admin 3 m % M«x“"’%
LastName User " o W
(TR— g Tatiner 3
Tite Administrative As sistant 3 5 e “ :
o) ® vt o dackKaser ) |
Job Title 0 Lt o secom &
Industries (IND 2 & Chitno Chin Newman <
Department (IND) ‘\,«\V“& £l Stionn sl 47 ogiching, Hal P 2
Work# (1)650 +1-866-888-8868 ot 4 [ CLEd e Auiting g
. @ Sinvaisen  HAl Stiomba ) Bekontial g ,,
Mabile # R e S e et k: eo0is Badite |
=, gl o s S v e Hsan. Map deta 62012 Google - Terms of Lse @

11. Rename this page to Venues

12. Add widgets Venues Table and Events Map by double clicking or drag and dropping the widget to the Venues
page
13. Change the position and size of the widgets

SAP Events on demand

Venues Table

+

Venues Map
a Campyg m
Greate | | Moaty || Delete | | Reloa % Oive [wiap | sat | Ter [ £amn ]
B Name Strest City State Zip Code F
Orange County Convention Center 9800 Intemational Drive Orlando L 032819 Stanford University § %‘.’ L.}
5 450 Serra Mall

8t 450 S¢ A 8t

Standford Uniw 0 Serra Mall, C anford cA ey £Y

St John's University 8000 Utopia Parkway Queens Ny 1439 (650) 723-2300

©

Ry stanford edu

a

Search nearby more~

92012 Google”
e 18 Braun M Map dats 92012 Boogie’s Terims of Use
L 3 otax

4

®0

14. Add a third page by pressing the + icon next to the Venues page



15. Rename this page to Team

16. Add widgets Team Table and Person Details by double clicking or drag and dropping the widget to the Team
page

17. Change the position and size of the widgets

SAP Events on demand

Events Venues

Team Table Person Details
Reload 2 Details
Admin User Administrative Assistant Industries (IND) :: z::: 2::,
Administrative Assistant Industries (IND) Title ‘Administrative Assistant
L Department Industries (IND)
1 Work# (1) B50 +1-888-888-8888
Change the site theme
1. Go Back to site directory by clicking on the arrow icon on the bottom right
2. Navigate to Themes tab
SAP SAP NetWeaver Cloud Portal Hello Ben

SITEDIRECTORY CONTENT THEMES ROLES

Uss this screen to view your theme options and to selectthe theme for your sites. To modiy a theme, download its CSS file, edit it, and update the CSS file path
= Add Theme

Available Themes

Edit | | Delete || Download | | Setas Default

Name Desciiption Theme Creator

& Cloud Portal Theme The standard theme delivered with the product (read-only} SAP



3. Download the default theme

Available Themes

Edit | | Delete Set as Default

Mame

l W Cloud Portal Theme

4. Edit CSS file
a. Open the saved CSS file with any text editor (notepad/notepad++ etc’.).
b. Search for “site-background” string (ctrl+f).
c. Replace the data Uri (in the url property) with the following URL:
http://t3.gstatic.com/images?g=tbn:ANd9GcS4idLfnJgEOxoe4buoTmYc-ED]UhCpD8Zh-k8If WD8kg-

G77Zs3q

/* Site background properties */
.site-background {

background-image:
url(http://t3.gstatic.com/images?q=tbn:ANd9GcS41idLfnIgEOxoe4buoTmYc-EDjUhCpD8Zh-
R8If _WD8kRg-G7Zs3g);

background-size: auto;

background-color: whiteSmoke;

background-repeat: repeat-x;

background-position: @ 37px;

d. Note: the default data URI is a very long string
e. Save your changes
5. Create new Theme
a. Back to Cloud portal, in the Themes tab click +Add Theme button

SAP SAP NetWeaver Cloud Portal Hello Ben | O

SITE DIRECTORY CONTENT THEMES ROLES

Use this screen to view your theme options and to select the theme for your sites. To modify atheme, download its CSS ile, edit it, and update the CSS file path
+ Add Theme
Available Themes

Edit | | Delete | | Download | | Setas Default

Name Description Theme Creator

Y Cloud Portal Theme The standard theme delivered with the product (read-only} SAP

b. Inthe Add dialog enter the following:

i. Name: My new theme

ii. Description: <free text>

ii. Theme Creator: <your name>

iv. CSS file: browse the file you edited in the step before


http://t3.gstatic.com/images?q=tbn:ANd9GcS4idLfnJgEOxoe4buoTmYc-EDjUhCpD8Zh-k8If_WD8kg-G7Zs3g
http://t3.gstatic.com/images?q=tbn:ANd9GcS4idLfnJgEOxoe4buoTmYc-EDjUhCpD8Zh-k8If_WD8kg-G7Zs3g

Add Theme X

*MName MyNewTheme
Description new theme

Theme Creator Ben

*53 File | hownload.css || Browse...

6. Enter site “Events on demand”
a. Navigate to site directory tab
b. Hover “Events on demand” site and click “Open site for editing” button

SAP SAP NetWeaver Cloud Portal

SITE DIRECTORY CONTENT THEMES ROLES

@ sites: Al (2) + Published (0)
Sort by: Name =7,

Events on demand
Q Manage events, venues and participants
Date Created: 21.09.2012 02:41

LastModified: 21.09.201203:02
Status: ¥ Offline

B Open Site for Editing o

7. Preview and apply theme
a. Click on Themes icon in the site Authoring panel
b. Inthe Theme catalog at the bottom, preview “My new Theme” by clicking it once
c. Apply new Theme by pressing the long button above the theme tiles

Themes

D Preview: MyNewTheme: New theme:

SAP Sample Site

Sample Page Sample Page Sample Page

Sample Widget = sample Widget

R\ &

Cloud Portal MyNewTheme
Theme




In this exercise we will preview our site in tablet, publish the site and view it in consumption mode.

Preview site in tablet

1. In order to see what your site will look like on mobile, click on the site simulation icon at the site Authoring
panel

2. Choose landscape/ portrait view by clicking the mobile icons at the top right corner

3. Close the site simulation by clicking the blue arrow located at the top right corner of the panel

Site Simulation

SAP” Events on demand

I Events Table

Publish the site

1. Click on the Settings icon in the site Authoring panel — blue strip at the right
2. Click the Publish button at the bottom of the panel

3. Approve publishing the site in the confirmation dialog

SAP" Events on demand

Events Table
Croate Reload
"
© Name venve sunOae €na Date a . et
Pitps fcdouds essiondleched2012
Stdent Oay 5t Jonn's Unwersity 2010-03-0671227.001011 2010-0906T1227001011 om
mship Standtora nnersity 201001-06T1227.001011 2010-09.0671227.001011 o
[
" Events Participants ™ Events Map
Attending People 7 Ben Aalo, 210920120339
g o
United States
Make this site available to invited users
o #2012 Google
Gocgle [

Settings >
Events on demand *

Uanage events, venues and parcipants.




Publish Site X

Publish this site to make it available to invited users. Users will now
receive their invitations together with a notification that the site is
published.

Are you sure you want to publish the site?

| Publish || Cancel |

4. Close the dialog says the site is now published

View site in consumption mode

5. Still in the Settings panel, right click on “Go to user site” and choose to open the link in new tab in order to see
the site in consumption mode

Settings

Events on demand +

Manage events, venues and participants

Site URL

hitps:/cloudsessionbteched2012-

teched2012.netv ondemand.com/por
portalfindex.html?id=d676fca3-eb36-4424d-
8529-0b482f01df2b&mode=consumption

B} Edit Site Name in URL

Access User Site
¢Ey Goto user site
28 Display QR code

Date Created
21092012 02:41

Last Published
Ben Aflalo, 21.09.2012 03:57

Last Modified
Ben Aflalo, 21.09.2012 03:39

Site Status
4 Published

“¥ Take Offline

Note: only published sites have this ability.
6. See the created site in consumption (navigate between pages, maximize widgets, select table entries, etc.)



SAP" Events on demand
T T

" Venues Table

G [ oat || oove 1] || Reoed = £ o [ [ ot [ e [Eam]}
® tame seet o s ZpCose ;
L Stanford University x o\"
50 Serait

Stanford, CA 94305
(650} 723:2300

St John's Urwersty 8000 Utopia Pariway Quaens W 19

Gay
Yoz g,




